
KPIC Facility Observing Instructions 
Updated: 17 December 2024 

Overview  
This procedure outlines typical KPIC on-sky science operations for the Phase I Facility 
Mode. Its goal is to guide the user through taking K band science data using the 
facilitized Phase I mode of the instrument. It is adapted from the procedure developed 
and used by the KPIC team in the PI mode, with modifications to simplify unnecessary 
steps while ensuring reliability and stability.  

From a top-level, the procedure strives to:  

●​ Startup: Prepare the instrument for on-sky use assuming daytime 
calibrations have previously been completed 

●​ Observing: Complete an observation of a science target, including on-sky 
calibrations, measuring throughput, activating tracking on the tracking 
camera, etc.  

●​ KPIC Shutdown: Place the system in a stable “standby” mode after 
observations and take NIRSPEC backgrounds after going on-sky 
(End-of-night script section) 

 

Syntax Overview 
Orange machine font is for commands meant for a normal KPIC (nfiuserver) terminal  
Blue machine font is for commands meant for the kpython3 instance on nfiuserver  
 

The appendices of this document include: $S 

●​ A0: Default Facility-Mode stage positions 
●​ A1: Lexicon – Useful acronyms and other terms  
●​ A2: NIRC 2 Observation Instructions 
●​ A3: Throughput Calculator Instructions 
●​ A4: Tracking Loop Control 
●​ A5: KPIC GUI Reference Photos 
●​ A6: Opening the GUI and other Elements of start_kpic_obs 

 

 
This guide assumes that KPIC FIU has been aligned and calibrated according to the 
procedure in the Daytime Calibration Procedure (alternate link to sharepoint version). 

https://etlab.caltech.edu/instruments/kpic
https://caltech.sharepoint.com/:w:/r/sites/coo/Shared%20Documents/OIR%20-%20Preprojects/KPIC/KPIC%20-%20Project%20Management/KPIC-Facilitization/KPIC_Facility_Daytime_Calibrations_Procedure.docx?d=wf4c0efabda3d46a2a66ad30166d4dba8&csf=1&web=1&e=dF2bt8


Startup (to be done ~20 mins before sunset)  
1.​ Make sure that any backgrounds that were queued after daytime calibrations have now 

completed. If they haven’t, stop them in the NIRSPEC Xterm command line with a Ctrl-C. Note 

the last frame taken in the observing log. 

2.​ Check for an open VNC to the KPIC server (referred to as nfiuserver 

in this document). This VNC is usually opened in one of the NIRSPEC 

VNCs, oftentimes in the “control1” VNC since we don’t usually use 

SCAM during KPIC observations. Make sure to check the other 

desktops in the NIRSPEC VNC to make sure the KPIC VNC isn’t on a 

different tab - you can click on the various quadrants of the “nirspec 

Desktop” GUI (screenshot at right) to check the different desktops. 

a.​ If you can’t find the nfiuserver VNC, reach out to your SA or 

OA, who will know the right VNC session and password to connect. 

3.​ (This step, 3, should very rarely be needed, as the SAs will leave the system set up for you).​
If for some reason you need to start the entire system instead, you can start all the KPIC software 

by running KPIC_init  in any nfiuserver terminal.  

4.​ Open the KPIC GUIs/Windows needed for nighttime observing in the nfiuserver VNC. To do this, 

open a new terminal (can be done from “Activities” at top right of the VNC session) and enter 

the following command: start_kpic_obs 

a.​ This will open various elements as shown in the screenshot below. Check that you have 

the following elements. If you are missing any, see the instructions in Appendix 6 for 

information on how to open that one specifically. Otherwise, proceed to step 5 below. 



i.​ KPIC Display - Facility Observers GUI 

ii.​ H-band Strehl Calculator terminal (Note: 0.2 - 0.3 on this calculator is very good) 

iii.​ Throughput Gui - NOT a Facilitized feature, Not supported by Keck SA,OA or KPIC 

Team. Works on K-Band science with high star mag. 

iv.​ Terminal with 2 tabs: 

1.​ A “Throughput Calculator” tab (Note: 3-5% throughput is pretty good) 

2.​ A “kpython3 for Observing” tab 

v.​ “KPIC Stages Status” GUI (KPIC DM GUI) 

5.​ Other helpful VNCs to keep open: 

a.​ NIRSPEC control2 (with the Ginga Spec Viewer): this window displays the NIRSPEC data 

and allows us to examine the science data quality 

b.​ NIRSPEC telstatus: this typically has MAGIQ with the starlist for highlighting new targets 

for the OA, as well as the status of the telescope. You can check if the starlist has the 

right format via “Load Private Starlist” under “File” 

c.​ Note: a NIRC2 VNC is no longer needed. We can use ‘ssh nirc2eng@waikoko-new "rotate 

[PA] posang"’ from any nfiuserver terminal to control the rotator. 

d.​ When the OA is opening, they will need to set up the AO to use KPIC (this will be the 

same as the NIRC2 pointing origin and cog file but with the right focus position for KPIC). 

“KPIC” must be used even though the science detector is NIRSPEC. 

i.​ This can cause confusion if the OA asks “which instrument are you using tonight” 

as AO should not be set up for NIRSPAO; they should use “KPIC”. 

e.​ Once the instrument has been selected by the OA, Run the start of night AO script from 

Maori.   

6.​ Note: If the first half was a regular NIRSPAO night, you might need to change the NIRSPEC filter 

settings. Access the NIRSPEC Filter setting in the NIRSPEC Control2 window under the “NIRSPEC 

instrument control” subwindow by clicking on the “Filter” Button. Set the filter to “Kband-new” 

 

Observing  
1.​Run the onsky startup script  

a.​ While slewing to the first target (usually the wavecal star), run: kpic_onsky() 

b.​ It will ask “Ready to turn on DAR? (Y/n)” → enter “Y” (Facility mode needs DAR on-sky). 

c.​ It will then automatically suggest a DM map. If this is the desired DM map, enter ‘Y’ to 

accept it and have it loaded onto the DM. If you select ‘Y’ (which you usually will), 

proceed to Step 2 “Required Calibration targets” . Otherwise read the sub-steps below.   

i.​ Only if this is NOT your desired DM map, then enter ‘n’ and proceed to the 

sub-bullets below, which show you how to load a specific flatmap.  

ii.​ Locate the latest DM map. This map will always live in 

‘/nfiudata/rtcdata/calibration/BMC/’. It is usually the latest map, with naming 

convention e.g. 

‘/nfiudata/rtcdata/calibration/BMC/NCPA_map_ds_sf2_230603.npy'.  



1.​ Note: You can easily list the latest 10 DM maps by entering the following 

command into a new nfiuserver terminal (not in the Throughput 

Calculator or kpython3 for Observing tabs): ​
ll -rt /nfiudata/rtcdata/calibration/BMC/NCPA_map*.npy | 

tail 

2.​ If you are uncertain which map to use, ask whoever ran the daycals 

(usually the SA for facility mode). 

iii.​ Once you know what DM map file you want to use, load it on the BMC DM by 

running flatten_BMC() in the kpython3 session: 

1.​ This will suggest using the default recent map (same as kpic_onsky 

suggested). Enter “n” to tell it not to use that map.  

2.​ Then provide the new filename you want to use. Ex: you can enter​
NCPA_map_ds_sf2_230603.npy if that’s the file you determined. 

iv.​ Alternative: if the flatten_BMC() function does not work for you for some 

reason, you can explicitly load the DM map manually: 

1.​ Create a variable in the kpython3 session called dmmap_file, where 

dmmap_file (string) is the full path of the KPIC DM map from day cals. 

Enter the file name as a string, e.g. ​
>> dmmap_file 

=‘/nfiudata/rtcdata/calibration/BMC/NCPA_map_ds_sf2_2

30603.npy’ ​
>> flat = np.load(dmmap_file)​
>> DM.setSurf(flat) 

 

2.​Required calibration targets: 
a.​ Wavelength calibration (MIII star): a calibrator star is used for wavelength calibration. A 

bright giant (III) M type star is ideal because it has numerous deep molecular features 

(like CO) that can be fitted. Take 2-3 images for each of the four fibers. 

i.​ Example: HIP 81497, HIP 95771, HIP 62944, HIP110882 (depending on the 

condition, the integration time could be 1.5-30 sec; observers should run a short 

test exposure to check the condition). See a suggested list of calibrators here. 

ii.​ Note that sometimes under very good conditions, using even the smallest 

NIRSPEC integration time (1.5s), the spectra will be saturated on NIRSPEC 

(>20000 counts, pro tip: use fiber 2 to check counts as it typically has the highest 

throughout). In this case, you need to offset the star to get lower counts. Using 

30 mas, 45 mas, or 60 mas will usually work. Look at Step 8.c.ii-iii to see how to 

determine the number of counts on NIRSPEC by drawing cuts. Step 9 shows how 

to offset to a companion; you can use the same steps to offset the wavecal. 

b.​ Spectral traces calibration (A0 star): the location and width of the traces for each fiber 

and each spectral order is typically derived from observations of an A0 standard star. 

This A0 star can be the telluric calibrator star for the science target. A smaller number of 

spectral lines make the trace calibration more robust. Take 2-3 images for each of the 

https://docs.google.com/spreadsheets/d/1C7PgRVMKgN5a2E9qg7lTHm-OAML767b6jJzh64ugpTU/edit?usp=sharing


four fibers (again, observers should run a test exposure to determine the proper 

exposure time and offsetting may be necessary as explained in 2.a.ii for the wavecal). 

Calibrating all the fibers even if they are not all used for science will simplify the analysis.  

i.​ A list of B, A, and F type stars used for previous KPIC observations can be found 

here: . These can be used for spectral trace KPIC_calibrator_stars_final

calibration or as a telluric calibrator.  

 

 

3.​Slew to Target 
a.​ Pick Target from target list in MAGIQ, right click and highlight it, and  ask OA to slew to 

the target  

b.​ If OA asks, we want the KPIC pointing origin. 

c.​ While slewing to target, it is a good time to take a CRED2 background.  

i.​ The CRED2 is the detector used for tracking and keeping the target on the fiber. 

It is the live image shown in the KPIC display. 

1.​ The CRED2 operates in H band for K-band science 

ii.​ Set the CRED2 Hmag close to the star’s Hmag using the drop down option at the 

lower left hand corner of the main KPIC GUI.  (see lower arrow in screenshot). 

Generally you want the peak counts for the PSF on the CRED2 to be below 

10,000 (the linear limit); ideally it should be between 2000-5000 (to make sure 

you balance solid signal and operating frequency).  

1.​ Depending on the conditions, you might need to set an Hmag setting 

that is different from the true Hmag of the target.  

2.​ In special cases when the target is very bright such that you exceed 

10,000 counts at the lowest Hmag setting, you should set the “FPS” 

(Frame per second) and  “Tint (ms)” so that the CRED2 counts are 

reasonable. To do this, select “custom” in the Hmag presets and first set 

the FPS (with a maximum value of 600) by entering a value and clicking 

https://docs.google.com/spreadsheets/d/1gcC9nqcXsGcZwP5Qe6XH-uSGkNp7DDeGGxksMrb8MiI/edit?usp=sharing


anywhere else in the GUI to get it to apply. Then set the tint until you 

no longer saturate, again clicking anywhere else in the GUI to get the 

new tint to apply.  

iii.​ In the Image tab, make sure the “Bias/Dark” and “Move FAM” checkboxes are 

ticked. Then click the “Save” button next to them (see upper right in screenshot 

above). Wait for the background acquisition to complete - the Save button will 

be depressed and will say “Saving…” until it finishes; you’ll know the 

background is done when the button says “Save” again.  

1.​ NOTE: (This is very very rare but…) if the star, or a visible companion, 

remain in the field of the CRED2 during the save, you can retake the 

background with manual FAM movement, following the instructions in 

Step 5 of Appendix 4.​
 

iv.​ Generally speaking, you should take a new background any time you change 

the CRED2 settings or if the sky background conditions change. Doing so will 

prevent image processing (display) issues. 

 

4.​Prepare to Offset to Companion (optional) 
a.​ If you need to offset the fiber to a companion, now (while slewing)  is a good time to 

look up the offset (may be available from whereistheplanet.com). Write down the 

Separation and PA. Don’t activate the offset yet. 

5.​NIRC2 Rotation (if the companion separation >2.0”) 
a.​ While slewing to target, and if we need to offset by > 2.0” (Sep > 2000 mas), inform the 

OA you will rotate the instrument (NIRC2) rotator. 

b.​ In an nfiuserver (ie. KPIC) terminal, type ​
    ‘ssh nirc2eng@waikoko-new "rotate [PA] posang"’ (if using fibers 1 and 2)​
 or ​
    ‘ssh nirc2eng@waikoko-new “rotate [PA+180] posang”’ (if using fibers 3 and 4)​
where [PA] is the Position Angle of the offset you want to make (i.e., PA of the 

companion). Note that with large offsets requiring image rotation, you can only fiber 

bounce between either fibers 1 and 2 or between 3 and 4. It is not possible to bounce 

between 2 and 4 with large offsets, for example. (This is due to KPIC TTM/FAM limits) 

c.​ Wait for the rotator to finish (may take a minute), and inform the OA when we are done 

so they can acquire. 

6.​OA Acquires Target 

7.​Setup Tracking on CRED2  
a.​ After the OA has acquired the target and closed the AO loops, get the system ready for 

tracking. Click on the Tracking tab in the KPIC GUI and perform the following  

b.​ Check that DAR Offset is On (this is at the bottom of the Tracking tab, it should be green) 

http://whereistheplanet.com/


c.​ Confirm the Hmag of the camera (dropdown on the lower left of the GUI, under the live 

image) is set to the nearest Hmag of the star we are tracking on. 

d.​ Check that the counts on the CRED2 (tracking camera) are “good”.: 

i.​ A “good” number of counts for the star is ~2,000, and should be displayed  in the 

upper right of the image. Max >10,000 is too high (non-linear). See Step 3.c.ii 

above for more details. 

 

ii.​ If the counts are not “good”, change the CRED2 Hmag setting until the counts 

are within range. You might need to use a higher Hmag setting if there are 

clouds causing extinction, for example. If you are still running into issues, you 

can increase the number of images that the tracking camera uses to track by 

changing the “average” number in the “Tracking” tab. 

iii.​ Sometimes, under bad weather condition (cloudy, bad seeing, low-wind effect 

for AO correction, etc), or when the offset is large, the star end up out of CRED2 

filed of view. When you are not integrating on NIRSPEC, or you if think you 

wouldn’t get any flux on the companion anyway, you can try to set “FAM” (Fiber 

Alignment Mirror) on the “Devices” tab back to “center” to re-acquire the star.  

e.​ If you changed the CRED2 settings since the last time you took a background, take a new 

one (see Step 3.c above).  

i.​ NOTE: it is a good idea to take a background for the CRED2 each time you 

change the CRED2 settings. This helps prevent processing (display) issues. 

f.​ Turn on Tracking. Set the goal in the dropdown tracking menu to a science fiber.  

8.​Begin acquiring NIRSPEC images of the star [if desired]  
a.​ On the Tracking tab, check that there are no offsets. When there are no offsets, the 

values in the “Distorted” column should be zero regardless of what the “raw” says. 

b.​ Click on the Acquisition tab of the Viewer GUI. In the “SPEC” section, set the NIRSPEC 

exposure time as desired. (You can also do this in the regular NIRSPEC Spec VNC window 

with “atint” in a NIRSPEC xterm)  

i.​ In K-band, the exposure time should be fairly short (<= 60 seconds) unless the 

target is faint (Kmag > 8)  



 

c.​ (Optional): take a single NIRSPEC exposure using the “Acquire” button to check if the 

integration time is suitable. After the exposure has completed, in the NIRSPEC VNC with 

the Ginga GUI (control2, by default), check that:  

i.​ For the star, we want (> 1000 counts for telluric standards and wavelength 

calibrators) and (< 20000 counts including background) per pixel to have 

sufficient counts and be within the detector linear limit. Adjust the NIRSPEC 

exposure time as needed.  

ii.​ An effective way of checking this value is by using the “Cut” tool provided by the 

Ginga GUI. Under Plugins -> Analysis, select “Cuts” (see screenshot below) 

  

iii.​ Select “Draw” in the dialogue window, and use your mouse to draw a line across 

the trace of interest. The plugin will show a pixel count vs line index histogram 

that is defined by the line you drew 

 



d.​ Decide which fibers you would like to collect the spectra through. The standard choice is 

the two highest throughput fibers determined by the initial telluric standard star. 

Bouncing the target between two fibers allows for better background subtraction 

during data reduction and is the recommended way to use KPIC.  

e.​ In the Nodding section of the Acquisition tab, define which fibers you’d like to collect 

data on in the “Sequence” field.   

i.​ If you want to collect data on SF1, SF2, SF3, set this to be “1,2,3”  

ii.​ Note that you can set up an ABBA pattern by entering the same fiber multiple 

times in the sequence, e.g., “2,4,4,2” to do ABBA with fibers 2 and 4 

f.​ Decide on the number of exposures per nod position and the number of iterations 

(number of times to repeat doing the fiber bounce).  

i.​ Total number of frames per fiber = (# exposure per fiber) x (# iterations)  

g.​ Click “Start Bounce” to start the exposure sequence. This will automate the fiber 

tracking to iterate the star over the desired fibers, as well as take NIRSPEC exposures 

synchronized with when the star is on that fiber. The script will stop when the requested 

number of iterations have been completed or the halt button is press  

i.​ Keep an eye on the exposures to make sure the counts are suitable (> 100 

counts and < 20000 counts per pixel).  

ii.​ Use the halt button to cancel the exposure sequence early. The current exposure 

on NIRSPEC will still finish and the system will be ready for a new sequence.  

iii.​ If the fiber bounce part of the GUI is not working, you can use a terminal 

window to run fiber_bounce: 

1.​ In a new nfiuserver terminal (not the Throughput Calculator or kpython3 

for Observing ones) type: Fiber_Bounce <list of fibers> <# 

exp per fiber> <# of iterations> --wait 

2.​ For example, to do a sequence of 3,4,3,4 you would do: ​
Fiber_Bounce 3,4 1 2 --wait 

9.​ Begin acquiring NIRSPEC images of a companion  

a.​ In the Tracking tab, put in the Separation and PA of the companion, and click the “⏎” 

button to apply the offset. Wait a moment as the tracking script computes and updates. 

 

i.​ The star should move off the fiber  



ii.​ If the “distorted” values do not update, you may have attempted an offset so 

large that the star would land off of the camera (the script prevents blocks to 

prevent this). In that case, try a different fiber, or change the rotator (see Step 5 

“NIRC2 Rotation”) to keep the star on the camera.  

b.​ Wait for the star to be offsetted to the correct position by monitoring the Δx/Δy fields in 

the Star Info section of the tracking tab (this can take a few seconds) 

i.​ If there are issues, try resetting the star to the center of the detector (Devices 

tab -> FIU -> Fiber alignment mirror -> Center). If you are doing a large offset, 

check you haven’t hit the limit of the Fiber alignment mirror (close to 0 or 

10000) 

c.​ Click on the Acquisition tab, and set the NIRSPEC exposure time in the Spec section.  

i.​ For companions (which are faint), you probably want an exposure time between 

60 and 600 seconds in K-band. We generally use 600 seconds as a default.  

d.​ Perform fiber bounce (see instructions in Step 8.g for how to run bounces)  

i.​ Unlike the star, it is difficult to know exactly how many counts to expect since 

speckles also leak into the fiber. Just make sure to not saturate (< 20000 counts 

per pixel)  

e.​ In order to analyze high-contrast observations of a companion, an empirical spectrum of 

the host star is needed to model the speckles.  This is repeated every 30-60 minutes 

(e.g., for offsets < 1”) by returning to the host star to collect stellar spectra. To do this, in 

the Tracking tab, put 0 in for the “Offset” separation and click the “⏎” button to return 

to injecting starlight in the fiber.  

i.​ Repeat the section above to take the spectra of the star  

ii.​ For offsets > 1”, the speckle field is probably so small you don’t need to bother 

returning to the host star multiple times. 

f.​ Repeat as needed (collecting companion + star data) until you reach the total desired 

exposure time.   



g.​ Note: for science sequences, we generally also want to collect spectra on a telluric 

standard for each fiber (every 1-2 hours), unless the host star is also an A0V star itself. It 

is good to do this before we slew to the science target, but it can also be done 

afterwards. The procedure is the same as collecting host star data.   

 

10.​ Before moving to the next object:  
a.​ Open the tracking loops on the KPIC GUI before asking the OA to open the AO loops and 

slew.  

 

KPIC Shutdown 
1.​ Once KPIC observing is done, setup KPIC for end of night by entering the command  

kpic_offsky(sam_rot_out=??) into the kpython3 session with spec_scans_combined in it 

(this terminal is called “kpython3 for Observing” if it is still open from the start of night). 

a.​ If you are handing over to NIRSPAO observers, use sam_rot_out=True. Additionally, 

this should generally be True if this is the last night of a KPIC run. However, if the next 

night is also a KPIC night, you can leave it as False. Important: sam_rot_out must be 

False to keep KPIC fibers in the slit for valid NIRSPEC backgrounds. So, if this is 

the last night of a KPIC run, remember to re-run kpic_offsky to remove the SAM 

rotator (by setting sam_rot_out=True) after backgrounds are finished.   

b.​ After the backgrounds are finished, you need to close the hatch on “NIRSPEC Instrument 

control”​

 

c.​ Finally, make sure to close the KPIC Facility Viewer GUI before logging off. 

d.​ Depending if this is the last night of a series of KPIC runs or not: 

i.​ If there is still another KPIC run for the next day, you can simKPply leave the 

NIRSPEC GUIs up, and type in a NIRSPEC xterm “newdir” to update the directory 



for the next day, so the date of observation will be recorded correctly for the 

next run 

ii.​ If this is the last night of a series of KPIC runs, you need to run the “End of Night 

Shutdown” script by: 

1.​ Right-click on the background of a NIRSPEC control window to get the 

pull-down menu. 

2.​ Select "NIRSPEC Control Menu" --> "End of Night Shutdown" 

2.​ To take KPIC science backgrounds: In a NIRSPEC terminal (xterm), type into a single command 

line (based on what integration times were used), e.g.:  

a.​ atint 1.5; goi 10; atint 5; goi 10; atint 15; goi 10; atint 20; goi 10; 

atint 30; goi 10; atint 60; goi 10; atint 90; goi 10; atint 120; goi 10; 

atint 300; goi 10; atint 600; goi 10  

b.​ The ; allows us to chain commands together. Each command will be executed after the 

previous one completes. This means you can send this all at once, and then work on 

something else while NIRSPEC completes the sequence. 

c.​ NOTE: the sequence above is just an example; make sure to update it with the 

integration times you actually used (or plan to use) on-sky.  

d.​ NOTE: If you use the example above, it will take ~4 hours to complete. 

 

On-Sky Troubleshooting/Debugging Issues:  
 
To debug/troubleshoot issues with KPIC while on-sky, see the troubleshooting document 
available: on the KPIC website (public - link) or on the KPIC sharepoint (KPIC team only - link) 
 
Note that we are still dependent on the AO system, so some issues may be due to the AO 
system rather than KPIC.  
 

The most common issue is the CRED2 freezing. The solution is shown on Page 5 of the 
troubleshooting document linked above, and below is a quick summary: 
 

1.​ Quick Fixes: Follow prompts provided after running the script. If this quick fix does not 
work proceed to step 2 

a.​ Processing frozen(view raw unchecked) - kpic_reset_shm PROC 
b.​ CRED2 frozen(view raw checked) - kpic_reset_shm CRED2 
c.​ Note: Try taking a new background or setting FPS after running a quick fix to 

ensure processing and cred2 control scripts are acting correctly. 
2.​ Kill the cred2 control script: tmux a –t Devices:Track_Cam then send a ctrl-c 

a.​ Note: when the control script dies, its tmux will also close and the next KPIC 
device’s tmux will open; be patient and check if you are still in the cred2 tmux 
BEFORE sending any further ctrl-c to avoid killing other device’s control 
scripts. 

https://etlab.caltech.edu/documents/30000/KPIC_Phase_II_troubleshooting_document_WebsiteVersion_18Dec2024.pdf
https://caltech.sharepoint.com/sites/coo/Shared%20Documents/OIR%20-%20Preprojects/KPIC/KPIC%20-%20Systems%20Engineering%20%5BL2%5D/KPIC%20-%20User%27s%20and%20Maintenance%20Manuals/KPIC%20Phase%20II%20troubleshooting%20document.docx?d=w566bdb1f977348ec82c5ec0f5e7df499&csf=1&web=1&e=nJJg95


b.​ If the control script doesn’t die, you’ll probably have to do a ps -aux | grep 
kpicctrl_Track_Cam, note the pid in the second column, and then use kill -9 
<pid>. Since we hard-killed the daemon, the shared memory didn’t clean up so 
delete the Tracking Camera’s DSTAT shm using: ​
rm $RELDIR/var/kpic/shms/Track_Cam/DSTAT.shm  

3.​ Now restart the track cam control script 
a.​ Start a new kpython3 session by typing kpython3 in a new KPIC terminal. 
b.​ In that kpython3 session, enter: 

from Track_Cam_cmds import TC_cmds 

tc = TC_cmds() 

tc.activate_control_script() 

tc.connect_camera() 

c.​ The connect_camera command is slow but if it returns after completion, you 
should now have live images. 

d.​ If you don’t have live images, try taking a new CRED2 background. 
e.​ If you still don’t have live images, try the “Processing Script is Frozen” entry in the 

troubleshooting document. 
4.​ If that still doesn’t recover things, go to the troubleshooting documents linked above and 

check other troubleshooting entries.  
 



Appendix 0: Default Facility-Mode Stage Positions 
While observing on-sky in Phase I Facility-Mode (K-band), the KPIC stages should be in the 
following positions. Note that the observer GUI (Viewer_Facility) lets you see the current state of 
all KPIC stages but does not let you move them. The stage labels used below match what the 
various stages are called in the “Devices” tab of the GUI.  If a stage is in the wrong position 
during Facility Mode observations, notify an SA who will have access to the SA GUI or will know 
how to move the stage from the terminal. 
 
 
 

 

Stage Facility Mode Position 

FIU Tab 

Light Source Retractor “out” 

Pyramid Pickoff “jband” 

Coronagraph “pupil mask” 

ADC Retractor “out” 

Atmospheric Dispersion Corrector (does not matter) 

Fiber Alignment Mirror “custom”  

Track Cam Pickoff “ds” 

Filter Wheel “h” 

Pupil/Focus Changing “focus” 

PIAA 

“out” 
 
NOTE: it is okay for the PIAA 
“more” button to be yellow. We 
keep the PIAA stage loops open. 

Multiport “kl bundle” 

FEU Tab 

Pupil Steering Mechanism “kl bundle” 

Pupil Steering Mechanism Focus ~2.51 (varies slightly) 

Slit Alignment Mirror “on slit” 

Slit Alignment Mirror Rotator “in” 

PD Pickoff “NIRSPEC” (and Powered Off) 



Appendix 1: Lexicon – Useful acronyms and other terms  
CRED2​ the KPIC tracking camera  
DAR​ ​ differential atmospheric correction 
DM​              deformable mirror  
DS​              direct spectroscopy  
DFB​              stage that picks off light from NIRC2 to send to KPIC  
DRP ​              data reduction pipeline  
FEU​              fiber extraction unit  
FIU​              fiber injection unit  
FSM​              field steering mirror (in K2AO) OR fast steering mirror (within KPIC)  
GUI​              graphical user interface  
K2AO​             Keck’s adaptive optics system, which feeds KPIC  
NCPA​             non-common path aberrations  
NIRC2             Keck’s imaging detector  
NIRSPEC       Keck’s high-resolution spectrograph  
PSM​              pupil steering mirror  
PyWFS           pyramid wavefront sensor  
SCAM​             a camera we use for aligning to NIRSPEC  
SFP​              the light source holder at the front of Keck  
SHWFS          Shack-Hartmann wavefront sensor  
SPEC​             camera for NIRSPEC  
PD ​              photodetector located at the output of the bundle for calibrations  
VNC​              virtual network computing (remote access to desktops)  

 



Appendix 2: NIRC2 Observations (for binary offsetting tests) 
a.​ Navigate to a nircx-control1 VNC window (may need to ask your SA to start this VNC for you) 

b.​ In a nirc2 xterm, type modify -s ao obdbname=dichroic to send light into NIRC2 

c.​ To specify exposure parameters, in a nirc2 xterm, type: 

a.​ tint # to set exposure time (ie. tint 0.5 for 0.5s exposures) 

b.​ coadd # to specify coadds 

c.​ filter <filter_name> (to specify a filter e.g. Kp) 

d.​ Note: For binary offsetting data, we typically take 0.5s exposures with 10 coadds in the BrG filter 

e.​ To take a NIRC2 exposure, type goi # in a nirc2 xterm window, where # is the number of 

exposures 

f.​ To send the light back to NIRSPEC, type modify -s ao obdbname=mirror 

Appendix 3: Throughput calculation 
NOTE: the KPIC throughput calculator and gui is provided as an extra utility for 
observers but it IS NOT a facilitized element. As such, observers are on their own to use it 
and SAs/OAs are not trained to support you with it. If you have issues with the calculator or gui, 
you may need to not use it for the night and reach out to the KPIC team after the night for 
details or support. 
 

1.​ The “Throughput Calculator” terminal and gui should open automatically at the start of 
the night when you run start_kpic_obs. If that terminal has been closed, you can restart 
it by: 

a.​ Terminal: 
i.​ Type kpython3 into a new clean terminal on nfiuserver (KPIC computer).  
ii.​ In this new kpython3 instance, enter:​

import throughput_calculator_newdrp as thpt  

b.​ Gui: In a new terminal tab type - kpic_throughput_gui 
2.​ In the kpython3 instance with the throughput calculator, set the base filename for the 

night, e.g.:   thpt.fluxbase = 
‘/sdata600/nspec6/2022oct11/spec/nspec221011_’ The path/filename will show 
up on the NIRSPEC PIG GUI on control0. Sometimes if the directory is not correctly set 
up, check if the directory is currently set as the previous night (This comes up if the 
newdir command was not correctly run for the day). 

3.​ Optionally, set thpt.darkind = <integer index of a dark frame> This frame will 
be used for dark subtraction when estimating the throughput. Make sure the integration 
time corresponds to the exposure you’re estimating throughput on. Defaults to None, 
which doesn’t do dark subtraction. Remember to update this or reset this to None 
when you analyze frames with different integration times on NIRSPEC. 

4.​ Set thpt.kmag = <kmag of source you’re calculating throughput for> 
Remember to update this when you move to a new source! 

5.​ To calculate the throughput, call: ​
_ = thpt.frame_throughput(fnum=<file index to calculate>) 



6.​ If the target is bright, you can capture the trace parameters and use them later for fainter 
objects, e.g. 

a.​ >> sf2 = thpt.frame_throughput(fnum=<file index number of a frame 

with a bright trace on sf2>)  
b.​ >> _ = thpt.frame_throughput(trace_loc=sf2, fnum=<file index 

number of frame with faint signal on sf2>)  
c.​ The trace finding is a lot more reliable if run on a bright source (>4k peak counts 

in NIRSPEC), so it’s good to save the trace locations from an initial wave/tel cal 
star to use for the rest of the night. Since the extraction is a box, it’s fine to use 
the wavecal star for this, but the throughput reported for the wavecal star is likely 
to be inaccurate due to the SED shape.  

d.​ The throughput calculation also assumes the source has an A0 SED. If the target 
is significantly redder (as is common for wavecal sources), the absolute 
throughput value should be treated with caution. 

 

Appendix 4: Tracking Loop Control 
 General Notes: 

1.​ To display the status of the Tracking script, connect to the tmux where it is running: 
a.​ In any terminal, type: tmux a -t Tracking 
b.​ To exit a tmux (such as this Tracking tmux), do Ctrl-b-d within the tmux 

session (ie. press and hold the “control” key, tap the “b” key, then let go of 
“control” and tap “d”). This exits the tmux session without killing the script inside. 

c.​ Caution: Do not ctrl-C in this tmux session. This will kill the tracking script. If you 
do accidentally kill it, press the “on”/”off” button for tracking in the Viewer. This 
should restart the tracking script. Toggle the button once or twice more to make 
sure the GUI tracking buttons are synchronized with the new tracking instance. 

2.​ Make sure to open the tracking loop (by clicking the On/Off button on the Tracking Tab 
of the GUI) whenever there is no light on the CRED or AO loops are open. For 
example, when you request that the operator slew to a new target, make sure to open 
the tracking loop before the AO loops open. 

3.​ You can reset the tracking settings to their Facility Mode K band default by running 
kpic_reset_tracking_for_facility from a KPIC terminal (not a kpython3 session). 

4.​ It is recommend to take a new background for the CRED2 whenever you switch to 
new CRED2 settings. The procedure for taking CRED2/tracking backgrounds is: 

a.​ Open the tracking loop. 
b.​ At the top of the “Image” tab in the Viewer GUI, there is a “Frame Subtractions” 

section. Make sure that the “Bias/Dark” and “Move FAM” checkboxes are ticked, 
then hit the “Save” button.  

c.​ You will see the “Save” button gray out and say “Saving” while this runs. Once it 
goes back to normal, the background is complete and you can start the tracking 
loop as normal, using the On/Off button in the “Tracking” tab. 



5.​ On rare occasions, a stellar companion can remain in the CRED2 field of view and 
be visible on the detector during the background subtraction. This will cause a dark, 
over-subtracted region in the CRED2 image. You can take a new background to correct 
this, but this time manually choose the FAM offset position to keep light off the CRED2: 

a.​ On the “Devices” tab -> “FIU” sub-tab,  find the  “Fiber Alignment Mirror” (FAM) 
section. This should be the only device that is controllable and not grayed out. 

b.​ Move the FAM to a corner of its range where there is no light on the detector. 
This is done by typing new values for the two entry boxes and clicking the “⏎” 
button next to them, one at a time. Note that sometimes the entry fields can be 
finicky, in which case just wait a moment (30 to 60 seconds) for them to recover. 

i.​ The FAM range is 10 to  9990. Thus (100, 100) is generally a good 
alternative position to the default “background” position. 

c.​ Now flip to the “Image” tab. Uncheck the “Move FAM” checkbox and then click on 
the “Save” button from earlier. Wait for the background to complete. 

d.​ Once done, go back to the “Devices” -> “FIU”  tab. Set the FAM to “Center” using 
the drop down options. The PSF should come back to the center of the CRED2. 

e.​ Now you can start the tracking loop again as normal. 



Appendix 5: KPIC GUI Reference Photos 
Example KPIC GUI tabs when you want to take CRED2 backgrounds or science exposures​

 



Appendix 6: Opening the GUI and other Elements of 
start_kpic_obs 
This appendix explains how to open the various elements of start_kpic_obs independently of that script. 

This could be useful if the script fails to open something or if you need to manually re-open one of them.  

 

1.​ Open the KPIC Observing GUI - There are three options for this: 

a.​ Option 1: Go to “Activities” (in the upper left of the screen) -> click the KPIC logo 

b.​ Option 2: Go to “Activities” -> type “Viewer” into the search bar -> select the “Viewer” 

option with the KPIC logo 

c.​ Option 3: enter Viewer_Facility into any nfiuserver terminal 

2.​ Open the KPIC DM GUI: enter kpic_lightsrc_gui -o into any nfiuserver terminal and  

3.​ Open the Strehl Calculator: open a new terminal on nfiuserver and enter tmux a -t Strehl 

4.​ Open a kpython3 instance for instrument control: open a new terminal on nfiuserver and enter 

kpython3 -i -m spec_scans_combined 

5.​ Open a terminal for computing throughput: (see Throughput calculation section) 

a.​ Note that 3-5% throughput is pretty good 
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